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I. Introduction





The Colored Two-dimensional Bar Code (C2DB) is a variation of the popular two-dimensional bar codes. It is a two-dimensional array of colored dots that can contain a high data density in a small physical space.  The addition of color to a two-dimensional bar code effectively adds a third dimension.  It can store more than 24,000 characters is a space that is only 130 mm x 40 mm.  C2DB has an error-tolerant design that can withstand a considerable amount of damage and distortion.  Many of the parameters surrounding the implementation of the C2DB are still as yet undefined.   The purpose of this work is to investigate some of these parameters involved in C2DB and to find optimal values for them. 





This paper builds in the work done in [8] and is organized as follows.  Section II provides background information on the C2DB symbol.  This is information on what has been defined so far for the C2DB structure and is essentially identical to that in [8].  Section III will describe the design of the proposed C2DB program.  This covers the program flow, program design structure and the user interface.  Section IV contains the state of the current implementation.  What has been completed, what still needs to be completed and what will not be completed is reviewed.  Section V is the conclusion and Section VI contains references.





II.  Background





II. a.  The C2DB Structure





The C2DB symbol is divided into fixed size units called codewords.  Each codeword contains 510 pixels that represent 255 characters.  That is each character is represented by 2 pixels.  510 pixels was chosen since it was determined as the optimal length to maximize error recovery and data storage [1].  Each pixel can take on 1 of 16 possible colors.  The number of colors can be increased to 256.  The characters that can be mapped by this process are the 256 of the ASCII character set.





The codewords are further broken in 17 “chunks”, each containing 30 pixels.  A chunk is shown in Figure 1.  This break up allows each codeword to be scattered within the symbol which results in enhanced robustness to error.  The chunks are scattered by first laying the first chunks of all codewords in row-major order followed by the second chunks of all codewords and so on until all 17 chunks of all codewords have been laid.  The C2DB symbol is shown in figure 2.  A header is placed at the lower left corner.  The header contains information about the structure of the symbol.  It contains:





the number of codewords


the error correction level


a flag indicating whether the data is compressed


a flag indicating whether the data is encrypted
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II. b.  Error correction and detection





Two types of error-related capabilities are provided


:


Error Detection: a self checking mechanism to assure data integrity.


Error Correction: a second mechanism to recover data that is damaged


				


A number of characters are added to each codeword in order to serve as a checksum.  Two types of problems are taken into account for





Rejection Errors:  occur when a codeword is missing or undecodable.


Substitution Errors: occur when a codeword is mis-decoded.





To allow for differing levels of error detection and correction depending upon the application and environment the symbol will be used in, eight error correction levels are provided.  Each codeword contains 255 characters and there is a linear relationship between the number of data characters and the number of checksum characters for every error level.





		Number of data characters  +  Number of checksum characters = 255





In [1], the error correction levels were defined as follows.  In the lowest error level, 0, all characters are reserved for data, thus, no error correction/detection is provided.  In error level 1, 223 characters are reserved for data and the remaining 32 are for checksum characters and an error loss of up to 6% can be corrected.  In the must robust level, 7, 151 characters hold data and 104 characters hold checksum data and an error loss of up to 20% can be corrected.  No additional information was provided in [1] related to the other error correction levels.  It was determined that the number of checksum characters for these levels should follow a linear distribution.  Table 1 shows the remaining distribution of data characters vs. checksum characters for the remainder of the error correction levels.  Those in italics have been added to supplement [1].�
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% Data Loss�
�
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Reed-Solomon codes are used to implement the error correction mechanism. It has previously been determined that this was the most effective mechanism to use [5].  In Reed-Solomon codes, the code words are constructed with symbols from Galios Fields.  They have the property that they can correct up to t lost symbols when 2t parity symbols are added to the codeword.  Based on this, Table 1 also shows the percent data loss that each error correction level can provide.





Reed-Solomon codes can correct both “erasures”, here called rejection errors, and substitution errors.  It can correct twice as many erasures as substitution errors.  They are also good at detecting adjacent errors or blocks of errors.  This is in line with our application of it to error correction for bar codes.  Errors to bar codes will typically be to adjacent data elements.  Many other bar coding techniques [3], [6], [7] use Reed-Solomon codes.





II. c. Compression





In the case where more than the 24,000 characters needs to be encoded on the symbol, compression is utilized.  The compression algorithm chosen is a mixture of Limpel -Zev and Arithmetic Coding.  A compression ratio of almost 3 : 1 can be achieved.  Compression is done before the encoding is done.  A flag is set in the header to indicate that the data is compressed.





A study of the literature on existing bar codes reveals a wide array of compression algorithms are in use.  The only consistency was that most had different modes depending on the type of data that the symbol contained; ASCII, binary, numeric, etc.  Most modes maxed out at around 3:1 compression.





III.  A Design for C2DB





III. a.  Development Environment





It was mentioned in [8] that the development tool might be Turbo C++ 3.0 for DOS or Microsoft Visual C++ 4.2 for Windows 95.  Turbo C++ is easier to implement in since it runs under DOS and, as such, graphical programming aspects would need not be considered making it a much simpler implementation.  Since the functionality here is purely data-oriented this would have been acceptable.  Even so, the chosen tool was Visual C++  and this was made for several reasons which are now described.





First, much of the C2DB functionality as described in [1] was already implemented using Visual C++.  This served as a foundation for the work done here.  Although, the implementation done for [1] was not commented and had a fair number of bugs so it was decided to start from scratch with a new implementation.  Even so, the code developed for [1] was a very handy reference and was indeed a time saver and its overall design and structure has been followed here.  A second reason for a ‘visual’ implementation is that it provided a great mechanism to provide feedback to the program’s user through a rich interface.  Since the program will be used for detailed analysis of the C2DB structure it is a fairly important requirement to be able to allow the user to have meaningful interaction with the program. A text-based approach may not have allowed this.  Thirdly, since the C2DB symbol is graphical in nature it seems inappropriate to have anything less that a graphical tool to work with it.





As mentioned,  Microsoft Visual C++ was the chosen compiler.  The C2DB program is being developed under Windows 95 using the Microsoft Foundation Class Library version 4.  The program as it currently stands should also run under Windows NT 4.0.  It is a 32-bit program.





III. b. The User Interface





To start to discuss the C2DB program it may be best to first look at its user interface.  The C2DB program is very much like many Windows program that work with documents (i.e. word processors, spreadsheets, presentation packages, etc.)  In the case of the C2DB program the document is the C2DB bitmap.  The name of the current bitmap open in the C2DB program is always displayed in the title bar.  The C2DB program has three pull-down menus; File, Action and Help. 





III. b. 1.  The File Menu





The File menu components are shown in Figure 3.





�





Figure 3


In detail, they are:





New: 	Allows a new C2DB file to be created.  The user is first prompted for the name of the new C2DB .bmp file.  Next, the user is prompted for the data file to create the C2DB with.  Third and lastly, the user is prompted for the parameters to create the C2DB with.  The dialog box that allows the user to select parameters is shown in Figure 4. 


Open:	Opens an existing C2DB file and makes it active.


Save:	Saves the active C2DB.


Save As:	Saves the active C2DB under an alternate file name.


Close:	Close the active C2DB.


Print:	Prints the active C2DB.  The output can go to paper, labels or any stock that can be printed on by a system attached printer.   It also has the capability to allow a Print Preview for examining the layout before printing and a Print Setup for setting various setting surrounding the Print such as orientation (landscape vs. portrait), printer to use, layout of page, etc. 


Exit:	Exits the C2DB program.


�


Figure 4





III. b. 2. The Actions Menu





The C2DB program is not just for creating and manipulating bitmaps.  This next menu is where the ‘Actions’ are.  They will allow analysis of C2DB designs to occur.  The Action menu components are shown in Figure 5.  They are:





Decode:	Decodes the active C2DB and produces a data file.


Compare:	Compares the active C2DB with a data file.  This will be useful when evaluating the robustness of a damaged C2DB.  The output produced will the percentage of the symbol that can be decoded.





�





Figure 5





III. b. 3.  The Help Menu





The Help menu is shown in Figure 6.   It contains options very similar to many other Windows programs





�





Figure 6





Not all C2DB menu options are available at all times.  Some are grayed out depending upon the state of the program.  For example, the Actions menu options of Decode and Compare are grayed out until a File is Opened or created New.  This aids the user in interaction with the program and guides them without forcing them into a rigid process of steps.





III. b. 4.  The C2DB Window





The C2DB Window has been designed with a three-paned approach.  It is shown in Figure E.  It consists of the Bitmap Values pane, the Message Log pane and the Codeword Distribution pane. 





The Bitmap Values pane shows the currently active C2DB in its graphical representation of colored pixels.  The window has scroll bars which allow navigation around  the bitmap should it be larger than the pane can show.  If printed, this is what will appear on the hard copy.  Its primary intent is to give the user feedback on the layout and shape of the C2DB structure.





The Message Log pane provides feedback to the user on the current operation.  The feedback can be on the form of a reiteration of the parameters used to create a C2DB, the time it takes to decode or encode a C2DB symbol, information about the C2DB or data files themselves, or, on a comparison operation, a statement of the correctness of the C2DB symbol.  This will be very important for using the program for analysis.





�


Figure 7





The Codeword Distribution pane displays how the codeword chunks are distributed in the current C2DB.  Each location in the matrix shows a value x.y where x is a codeword and y is a chunk within codeword x that holds that position.  This pane is useful for visualizing the effect of the distribution scheme chosen and seeing any problems it may have introduced such as chunks of the same codeword being too close to each other.  Codeword ‘0’ as shown in Figure 7 is the header.  In the final version the ‘0’ will be replaced with an ‘H’.











III. c. Detailed Design





Development under Visual C++ called for an object-oriented approach to the design of the program.  The main benefit of this approach is that it promotes code reusability.  An example of this will be seen in a later section.





The CRC (Class-Responsibilities-Collaboration) approach [9] to object-oriented design was employed.  In this approach cards, usually in the form of index cards, are used to detail each class.  Each card is titled with the name of the class that it describes.  Class hierarchy is reflected by a statement after the class name about any super-class it is related to.  Member functions are included in the Responsibilities section.  Member data items are included on each card under the Data Values section.  The Collaborators section shows the other classes that the given class needs to be made aware.





The cards that describe the C2DB program are included in Figures 8.a to 8.g.  Not all classes that are involved are shown, only those that are specific to the design here are represented.  For example, the CC2DBDlg class is a subclass of the MFC 4 CDialog class and gets much of its functionality from it.   Since this is not a lesson in MFC the reader is referred to a text on MFC for more details [10].  Only those additions to the CDialog class employed here are shown.





Following the MFC naming standard, class names always start with the letter ‘C’.  Member data values are named in such as a way as to identify them as such.  They all begin with the prefix ‘m_’.  This differentiates them from internal data values within the code.  Each member data value’s name also contains a reference to its data type.  After the underscore is a character indicating this type.  Some examples are i for int, b for BOOL, s for CString and f for float.  Note:  CString is a MFC 4 class [10] that represents a ‘string’ of type char’s.
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Figures 8.a and 8.b





The first two classes in Figures 8.a and 8. are related to the custom dialog boxes that make up the user interface used in the program.  They capture user input and provide feedback and results.  CC2DBDlg is the main application dialog that is depicted in Figure 7.  It contains only two data objects that must remain persistent across operations of the main application.  These are m_C2DBFile which holds the C2DB and is of type CC2DBFile and m_DataFile which holds the source data and is of type CDataFile.  The dialog described by CFileNewDlg is the one shown in Figure 4.





The next three classes in Figures 8.c, 8.d and 8.e describe the codewords.  The two subclasses of the CCodeword class are CHeaderCodeword and CDataCodeword.  Each have similar properties such as their size and a large block of data that needs to be manipulated but the data contained in each is very different.  CDataCodeword is just a ‘stream’ of data while CHeaderCodeword is much more structured in that it contains ‘fields’ of data that describe the C2DB it is part of.  These classes are mainly responsible for the conversion of a codeword from data values to bitmap pixels and vice versa.  CDataCodeword also adds the checksum bits used for error correction.





CC2DBFile is a class that contains the C2DB.  The CC2DBFIle is wrapper for a device-independent bitmap or DIB. The ‘DI’ in DIB means that it is not tied to any device, physical or virtual.  It is entirely self-contained since it contains all information about the location and colors of pixels for the image it represents and also contains a color palette that describe the colors that are used whether it be monochrome 16, 256 or 16 million.
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Figures 8.c and 8.d
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Figures 8.e and 8.f
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Figure 8.g





The CC2DBFile class reads and writes the bitmap, interpreting or creating the additional information in a DIB that include the size of the file, the dimensions of the graphic, the number of colors and the color palette itself.  It also handles the functions of inserting and extracting codewords into the C2DB.  These processes distribute or gather, respectively, the chunks of the codeword being operated on.  They do so via a ‘map’ that is created via the MapCodewords function.  MapCodewords takes information on the size of the source data file and the scheme selected to distribute codewords and builds a table that maps codeword chunks to locations within the C2DB.  This is exactly the map that is displayed in the Codeword Distribution pane.  It is key to both the encoding and decoding processes and is a perfect example of reusability.  The Visualize function is used to display the C2DB in the Bitmap Values pane.





The counterpart of the CC2DBFile class is the CDataFile class.  It serves many of the same operations that CC2DBFile did for DIB files including reading and writing and handling data going into and out of the object.  It also is responsible for compression and encryption.  These two functions are global to the data file unlike the error correction logic which is applied at the codeword level and implemented in the CDataCodeword::AddErrorCorrection function.





The program logic of the two most significant flows of processing is shown in Figures 9.a. and 9.b.  These flows have not changed from [8].  The encoding procedure is used in the CC2DBDlg::OnFileNew function.  The decoding procedure is used in the CC2DBDlg::OnActionsDecode function.
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Figures 9a. and 9b.





III. d. The Testing Process





The work in [8] hypothesized on some ways to test the robustness of the C2DB symbol by allowing the introduction of errors into t
